
The Game
Options
Q & A



The Game
The Basics
Scoring

Options
Q & A



The Game
The Basics
Scoring

Options
Menus
User
Game
Sound
Display

Q & A



The Game
Options

Menus
User
Game
Sound
Display

Q & A



Question & Answer

Q. How can I register Flashback?
A. I'm glad you asked. This is a very good question. You can register Flashback in one of two 
ways. First, by sending a check or money order to:

Greg DeBacker
638 San Juan Av.
Santa Cruz, CA

95065

Or, if you are a member of CompuServe, you can use their software registration feature (GO 
SWREG). Once there, use SWREG # 7041 and follow the on screen instructions.

Q. How much does it cost to register Flashback?
A. Another excellent question. The cost of Flashback is $10.00.

When you register the game you will receive a confirmation letter with your registration number.
Once you have received the Confirmation letter, select "Registration" from the Help menu of 
Flashback's main screen. Once the registration window appears enter your registration number 
and name exactly as they are printed in the letter and then click on OK. No disks will be sent.

Q. What do I get when I register Flashback?
A. Not only do you get the piece of mind that comes with knowing you did the right thing, but 
once you've registered Flashback the game loads much faster and does not display the logo 
screen in-between games. 

Also, the unregistered version only sccesses 10 quotes, but once you've entered your registration 
number the game has access to over 100 quotes!

Q. What language is Flashback written in?
A. Flashback is written in *Visual Basic 3.0.

Q. I had to get a copy of VBRUN300.DLL in order to run Flashback. What is this file?
A. VBRUN300.DLL is the run-time version of Visual Basic. It is needed to run all programs 
written in Visual Basic 3.0. VB stands for Visual Basic; RUN stands for run-time; 300 represents 
the version number; and DLL stands for Dynamic Link Library.

Q. I know my sound card is configured correctly because it works with other Windows 
programs, but it only works some of the time with Flashback. What's wrong?
A. If Flashback encounters any problems with WAV files while you are playing a game it simply
stops trying to play them. Go to the Sound section of the Options dialog box and select each 
WAV file you are using one at time and click on Test. If there is a problem with the WAV file the 
Test button will tell you there is a problem.



Q. Can I get a copy of the source code for Flashback?
A. No.

Q. What are the files FLASHBAK.INI, PLAYER.INF, and the USR files for?
A. FLASHBAK.INI stores the option settings for all the users so that every time a user starts a 
game the same options (e.g. Card Back, Display Quotes, Sound, ect) will be set as they were the 
last time they played. 

PLAYER.INF stores information about the players. Also, when you have registered, this is where
registration information is kept. If the PLAYER.INF file becomes corrupted and needs to be 
deleted it will be recreated the next time you play. If this happens, though, you will need to 
supply your registration number the first time you play the game after it has been deleted.

The USR files store the game histories for all the players in the User List of the User Options 
section of the Options dialog box.

Q. Where do I write to if I have comments about the game?
A. You can write to me at the same address you send your registration fee listed in the first 
question, or you can E-Mail me at:

CompuServe # 71042,36
Internet # 71042.36@compuserve.com

I encourage your comments, suggestions, and complaints.

Q. The cards are a mess of colors and I can't make them out. What's wrong?
A. The cards don't display properly if you are using a video resolution that displays more than 
256 colors. Change your resolution to either 16 or 256 colors.

* Visual Basic and Windows are a trade marks of Microsoft Corporation.



The Basics
See Also

You probably remember the game from your youth. Shuffle a deck of cards and turn them all 
face down and then turn them over two at a time and try to make pairs. The game was called 
Concentration.

This is the same idea but with a few twists. First off, you are racing the clock. The quicker you 
can find all the pairs the better your score. You can even put a time limit on yourself to see how 
many matches you can make in a given amount of time.

You can also set the number of seconds a selected pair is displayed. The shorter the time span the
selected pairs are displayed the better your score.

You are also judged on the average ratio of the number of pairs you had to turn over to make a 
match. The lower the ratio the better your score.

There are 4 levels of difficulty to chose from. At level 1, Normal, the play is normal. At level 2, 
Hard, the selected pair is swapped with two other cards on the table after every forth pair you 
select. At level 3, Harder, cards are swapped after every third pair of cards. At level 4, 
Ridiculous, the cards are swapped after every other pair.

To add a little fun to it, and possibly a distraction, you can set an option to have quotes by some 
famous, and some not-so-famous, people hidden in random locations under the cards. As you 
match pairs the randomly selected quote for the game becomes visible. The Shareware version 
accesses 10 quotes and the Registered version has access to over 100 quotes.

After you have matched all of the pairs, or when the timer runs out if one is set, the score 
window is displayed. You can view your current score from here and compare it to past games by
selecting game dates from the drop down box at the top of the scoring window.

All game dates displayed in the drop down box are for the current user only. The Current User's 
name is displayed in the title bar of    Flashback's main window.

After you have viewed the score for the current game and clicked OK to hide the score window, 
you will be shown the number of times you selected each card in the deck.



User Options

Access all the options by selecting "Options..." from the File menu.

User options is where you add your name to the list of players and set a player as the current 
player. Below is a description of the User Options:

User List A list of the available users from which you can chose.
New User Name Here you can type in your name, and then click on "Add" to 

add your name to the User List.
Add Button Adds the name you typed into the New User Name text box to 

the User List.
Remove Button Removes the name displayed in the User List from the User 

List.
Set Button Sets the name displayed in the User List as the current user. 

The Current User's name is displayed in the title bar of 
Flashback's main window.

Game Options

Access all the options by selecting "Options..." from the File menu.

Below is a description of the Game Options available to you.

Wait Before Hiding Pair Number of seconds the selected pair will be 
displayed. Range is from 1 to 3 seconds.

Time Until End Of 
Game 

Number of minutes before the end of the game. 
Range is from Unlimited to 3 minutes.

Difficulty Level Level of difficulty. Range is Normal, Hard, 
Harder, Ridiculous. See The Basics for 
explanations.

Display Quotes Hides a quote behind the cards to be uncovered as 
you match pairs..

Play Sounds WAV files are played on certain events when 
checked.

Card Back Allows you to select from the 4 card backs.

After you have changed any options be sure to click on the Save button to save your changes. 
The changes will not take effect until you have clicked on Save.



Sound Options

Access all the options by selecting "Options..." from the File menu.

If you have a sound card you can attach WAV files to events in Flashback. Below are a list of 
the events you can attach WAV files to.

First Card WAV played on your first selection.
Second Card WAV played on your second selection.
Match All WAV played when you've matched all pairs.
Times Up WAV played when the timer runs out
No Match WAV played when two cards don't match.
Match WAV played when two cards do match
Begin Game WAV played when the timer starts at the start of a game.

Flashback is shipped with several WAV files. However, you can chose to attach your own WAV 
files to the events listed above.

To the left of the listed events in the Sound section of the Options box there is a directory and file
list box for you to find WAV files on your computer's hard drive. Once you have found the 
specific WAV file you wish to attach to an event make sure that the specific event is selected and 
then click on the "Set" button.

If you don't wish to have a WAV file attached to a particular event select that event and click on 
the "Clear" button.

You can test a WAV file by selecting it from the file list box and then clicking on the "Test" 
button. If for some reason the WAV files are not playing during the play of the game, and you 
know that your sound card is set up correctly, the "Test" button will tell you if any errors where 
encountered while it was trying to play the WAV file.

Any errors encountered playing WAV files during the play of the game will be ignored and no 
error messages will be displayed. The WAV files will simply no longer play until you have fixed 
the problem or removed the offending WAV file.



Menus

File
Deal Deals the cards for a new game.
History Display the score window and a history of your games.
Options Access all the game options.
Exit Exit the game.

Help
Search Help Search this help file for a particular topic.
Help Contents Open this Help file.
Register Register your copy of    Flashback.
About View the About Box for information about version number and

system's resources.

Display
Below is a description of the display panel at the bottom of the screen.

Display Only
Pairs Matched The number of pairs matched in the current game.
Pairs Selected The number of pairs selected in the current game.
Percent Done Bar Percentage of pairs that have been matched.
Elapsed Time Time that has elapsed since the start of the game.
Time Limit Time limit set in the Game section of the Options dialog 

box.
Difficulty Difficulty level set in the Game section of the Options 

dialog box..

Buttons
New Deal Starts a new game
Show Deck Turns all the cards face up or face down depending on their 

current state.
Pause Pauses the game. Toggles the timer on or off.
Hint After you have selected the first card in a pair it will give you a 

hint as to were a match can be found.

When you pause the game the timer stops and there is no adverse effect on your score. You will 
not be able to select any cards until you have resumed the game. When you click on Show Deck 
to look at all of the cards the timer does keep going. You will not be able to click on any cards 
until you have hidden the cards.



Scoring
You goal is to get the lowest score possible. To be the fasted, most efficient, and accurate.

Below is a breakdown of the elements of the game you are scored on and their worth.

Pairs Matched One point subtracted for each pair matched.
Pairs Selected Per Match 20 points for each point of the ratio.
Elapsed Time 1 point for every 4 seconds of elapsed time.
Time Pair Shown 10 points for every second pairs are shown.
Number of Hints 5 points for each hint.
Deck Shown 5 points for each second you view the deck.
Time Limit No direct scoring, but it effects the elapsed time.
Difficulty             Normal - No effect on score.

            Hard - Subtract 20 points.
            Harder - Subtract 40 points.
            Ridiculous - Subtract 60 Points
           See The Basics for explanations.

If, for some strange reason, you select no pairs or match no pairs 100 points is added to the score 
derived from the above elements.

You can pause the game at any time by clicking on the Pause button in the lower right-hand 
corner. This will stop the timer and you will not be able to select any cards. Pausing the game 
does not adversely affect your score. To resume playing click on the same button which will now
be labeled "Resume".
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